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1. การประยุกต์การตกแต่งข้อมลู การจดัรูปแบบอย่างมีเงื่อนไข 

 (Conditional Formatting) 

การจัดรูปแบบเอกสารนั้น บ่อยครั้งที่จะต้องจัดรูปแบบโดยมีการก่าหนดเงื่อนไข ตัวอย่าง เช่น ต้องการ

จัดรูปแบบตัวเลขในกลุ่มเซลล์ มากกว่า 10,000 บาท ให้ตัวเลขเป็นสีแดง Excel มีเครื่องมือการจัดรูปแบบ อย่างมี

เงื่อนไขขึ้นมาซ่ึงมีข้ันตอน ดังนี้ 

1. เลือกกลุ่มเซลล์ที่ต้องการ  

2. คลิกเลือกเครื่องมือ Condition Formatting ที่แท็บ Home บน Ribbon ที่กลุ่มค่าสั่ง Styles  

3. เลือกรูปแบบเงื่อนไขที่ต้องการ  

 
รูปภาพท่ี 1 Condition Formatting 

ส่าหรับการจัดรูปแบบอย่างมีเงื่อนไข ได้มีการพัฒนาให้มีรูปแบบการใช้งานที่ง่ายและสะดวกขึ้น รวมถึง

สามารถวิเคราะห์ข้อมูลและจัดรูปแบบการแสดงผลได้อย่างมีประสิทธิภาพ ดังรายละเอียดดังนี้ 

- การเปรียบเทียบค่า (Compare)  

- การหาค่าสูงสุด/ต่่าสุด (Top/Bottom)  

- การสรุปผลข้อมูลโดยใช้เฉดสี (Data Bar)  

- การสรุปผลข้อมูลโดยใช้สี (Color Scales)  

- การสรุปข้อมูลโดยใช้รูปภาพ (Icon Sets)  
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1.1 การเปรียบเทียบค่า (Compare)  

การเปรียบเทียบค่าจะมีรายละเอียดคือ เปรียบเทียบว่ามากกว่ า น้อยกว่า เท่ากับหรือไม่ ซึ่งสามารถ
เปรียบเทียบค่าได้ทั้งตัวเลข และข้อความ ซึ่งมีลักษณะการใช้งานดังนี้  
1. เลือกกลุ่มเซลล์ที่ต้องการ  
2. คลิกเลือกเครื่องมือ Condition Formatting ที่แท็บ Home บน Ribbon ที่กลุ่มค าสั่ง Styles  
3. เลือก Highlight Cells Rules  
4. เลือกเง่ือนไขในการเปรียบเทียบที่ต้องการ  
5. ก าหนดค่าที่ต้องการเปรียบเทียบ  
6. เลือกลักษณะการจัดรูปแบบ  
7. คลิกปุ่ม OK  

ตารางที่ 1 การเปรยีบเทียบค่า 

ชนิดตัวเลข  ความหมาย  
Greater Than  เปรียบเทียบค่ามากกว่า  
Less Than  เปรียบเทียบค่าน้อยกว่า  
Between  เปรียบเทียบค่าที่อยู่ระหว่าง  
Equal To  เปรียบเทียบค่าเท่ากับ  
Text that Contains  เปรียบเทียบค่าที่ประกอบด้วยตัวอักษรหรือข้อความ  
A Date Occurring  เปรียบเทียบค่าที่เก่ียวข้องกับตัวเลขวันที่  
Duplicate Values  เปรียบเทียบหาค่าซ้ า  
More Rules  ตั้งเงื่อนไขเอง  

 
รูปภาพท่ี 2 การเปรยีบเทียบค่า 
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ผลลัพธ์ที่ได้จากการก่าหนดค่า 

 
รูปภาพท่ี 3 ผลลัพธ์ที่ได้จากการกา่หนดค่า 

1.2 การหาค่าสูงสุด/ต่่าสุด (Top/Bottom)  

เป็นการหาค่าโดยสรุป คือ การสรุปข้อมูลจากตาราง เพ่ือหาค่าสูงสุด ต่่าสุด หรือการหาค่าสูงสุด 10 อันดับ

แรก หรือการหาค่าเฉลี่ย เป็นต้น สามารถท่าได้ดังขั้นตอนต่อไปนี้  

1. เลือกกลุ่มเซลล์ที่ต้องการ  

2. คลิกเลือกเครื่องมือ Condition Formatting ที่แท็บ Home  

3. เลือก Top/Bottom Rules  

4. เลือกเง่ือนไขที่ต้องการ  

5. ก่าหนดค่าที่ต้องการสรุป  

6. เลือกลักษณะการจัดรูปแบบ  

7. คลิกปุ่ม OK  

ตารางที่ 2 การหาค่าสูงสุด/ต่่าสุด 

ชนิดตัวเลข  ความหมาย  
Top 10 Items…  สรุปข้อมูลสูงสุด 10 อันดับแรก (10 รายการ)  
Top 10 %…  สรุปข้อมูลสูงสุด 10 % ของรายการทั้งหมด  
Bottom 10 Items…  สรุปข้อมูลต่ าสุด 10 อันดับแรก (10 รายการ)  
Bottom 10 %…  สรุปข้อมูลต่ าสุด 10 % ของรายการทั้งหมด  
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ชนิดตัวเลข  ความหมาย  
Above Average…  สรุปข้อมูลที่มีค่ามากกว่าค่าเฉลี่ยของข้อมูลทั้งหมด  
Below Average…  สรุปข้อมูลที่มีค่าน้อยกว่าค่าเฉลี่ยของข้อมูลทั้งหมด  
More Rules  ตั้งเงื่อนไขเอง  

 
รูปภาพท่ี 4 การหาค่าสูงสุด/ต่่าสดุ 

 
รูปภาพท่ี 5 ผลการหาค่าสูงสุด/ต่า่สุด 
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1.3 การสรุปผลข้อมูลโดยใช้เฉดสี (Data Bar)  

วิธีนี้เป็นการเปรียบเทียบข้อมูลทั้งหมดแล้วมีการ Highlight เป็นเฉดสีลงบริเวณข้อมูล ซึ่งท าให้สามารถเห็น
ผลลัพธ์และเปรียบเทียบข้อมูลได้จากการสังเกตเฉดสี เหมาะส าหรับแสดงค่าข้อมูลที่เปรียบเทียบเป็นปริมาณ มาก 
น้อย ได้อย่างชัดเจน มีวิธีการดังนี้คือ  
1. เลือกกลุ่มเซลล์ที่ต้องการ  
2. คลิกเลือกปุ่มเครื่องมือ Conditional Formatting ที่แท็บ Home  
3. เลือก Data Bar  
4. เลือกเฉดสีที่ต้องการ  

 
รูปภาพท่ี 6 การสรุปผลข้อมลูโดยใช้เฉดสี (Data Bar) 

1..4 การสรุปผลข้อมูลโดยใช้สี (Color Scales)  

วิธีนี้เป็นการเปรียบเทียบข้อมูลทั้งหมดแล้วมีการใช้สีที่แตกต่างกันลงบริเวณข้อมูล ซึ่งท า ให้สามารถเห็น
ผลลัพธ์และเปรียบเทียบข้อมูลได้จากการสังเกตสีที่ใส่ลงในเซลล์ โดยจะแสดงแบบ  2 ระดับสี (ค่าน้อยที่สุดกับค่ามาก
ที่สุด) หรือ 3 ระดับสี (ค่ามาก, ค่ากลาง และค่าน้อย) มีวิธีการดังนี้  
1. เลือกกลุ่มเซลล์ที่ต้องการ  2. คลิกเลือกปุ่มเครื่องมือ Conditional Formatting ที่แท็บ Home  
3. เลือก Color Scales   4. เลือกเฉดสีที่ต้องการ  
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รูปภาพท่ี 7 การสรุปผลข้อมูลโดยใช้สี (Color Scales) 

1.5 การสรุปข้อมูลโดยใช้รูปภาพ (Icon Sets)  

วิธีนี้เป็นการเปรียบเทียบข้อมูลทั้งหมดแล้วมีการใช้รูปภาพที่แตกต่างกันลงบริเวณข้อมูล ซึ่งท าให้สามารถเห็น
ผลลัพธ์และเปรียบเทียบข้อมูลได้จากการสังเกตท่ีรูปภาพ มีวิธีการดังนี้คือ  
1. เลือกกลุ่มเซลล์ที่ต้องการ  
2. คลิกเลือกปุ่มเครื่องมือ Conditional Formatting ที่แท็บ Home  
3. เลือก Icon Sets  
4. เลือกรูป Icon ที่ต้องการ  
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รูปภาพท่ี 8 การสรุปข้อมูลโดยใช้รูปภาพ (Icon Sets) 
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2. การใช้สตูรและฟังก์ชันเพ่ือการค่านวณ  

การใช้งานในด้านการค่านวณ ซึ่งนับว่าเป็นอีกความสามารถหนึ่งที่เด่นชัดของ Microsoft Excel รวมไปทั้ง

ฟังก์ชัน ซึ่งก็คือสูตรการค่านวณที่ถูกสร้างไว้ มีลักษณะเหมือนค่าสั่งส่าเร็จรูป การท่างานเพียงแค่ระบุชื่อฟังก์ชันลงไป

ภายในเซลล์ที่ต้องการ ฟังก์ชันภายใน Excel มีให้เลือกใช้มากมาย ทั้งฟังก์ชันทางคณิตศาสตร์ ฟังก์ชันทางการเงิน 

ฟังก์ชันทางสถิติ ฟังก์ชันทางข้อความ เป็นต้น 

2.1 รูปแบบของสูตรค่านวณ  

การป้อนข้อมูลประเภทสูตรค านวณ (Formula) นั้นจะต้องน าหน้าด้วยเครื่องหมาย เท่ากับ “=” และต้อง
ประกอบด้วยตัวถูกด าเนินการ (Operand) และตัวด าเนินการ (Operator) 

 
รูปภาพท่ี 9 สูตรค านวณ 

2.1.1 ตัวถูกด่าเนินการ (Operand)  

ตัวถูกด าเนินการหรือ Operand สามารถก าหนดในสูตรค านวณ แบ่งออกเป็น 2 ประเภทคือ  
1. ค่าคงท่ี (Constant) คือตัวเลข ตัวอักษร หรือข้อความเฉพาะต่างๆ  
2. ชื่อเซลล์ (Cell Name) คือชื่อเซลล์ที่บรรจุข้อมูลอยู่  

 
รูปภาพท่ี 10 ตัวถูกด่าเนินการหรอื Operand 
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2.1.2 ตัวด่าเนินการ (Operator)  

ตัวด าเนินการ หรือ Operator แยกตามประเภทดังนี้  

1) ตัวด่าเนินการทางคณิตศาสตร์ (Mathematics Operator)  

ตารางที่ 3 ตัวด่าเนินการทางคณิตศาสตร์ (Mathematics Operator) 

Operator ความหมาย ตัวอย่าง  
+ บวก = A1+A3  
_ ลบ = B3-B5  
* คูณ = C3*5  
/ หาร = A1/100  
^ ยกกาลัง = 2^A2  
% เปอร์เซนต์ = A1*20%  
() วงเล็บ = ((A3+2)*20)/100  

 

2) ตัวด่าเนินการทางการเปรียบเทียบ (Comparison Operator)  

Operator ทางการเปรียบเทียบนั้นจะได้ค่าจากการค านวณ เป็น TRUE (จริง) หรือ FALSE (เท็จ) เท่านั้น 
โดยทั่วไปจะใช้เพ่ือน าไปตัดสินใจหาทางเลือกในฟังก์ชัน 

ตารางที่ 4 ตัวด่าเนินการทางการเปรียบเทียบ (Comparison Operator) 

Operator  ความหมาย  ตัวอย่าง ค่าที่จะได้เป็น เพราะ 
= เท่ากับ  =5=6 FALSE 5 ไม่เท่ากับ 6 
> มากกว่า  =5>6 FALSE 5 น้อยกว่า 6 
< น้อยกว่า  =5<6 TRUE 5 น้อยกว่า 6 จริง 
>= มากกว่าหรือเท่ากับ  =5>=6 FALSE 5 น้อยกว่า 6 
<= น้อยกว่าหรือเท่ากับ  =5<=6 TRUE 5 น้อยกว่า 6 จริง 
<> ไม่เท่ากับ  =5<>6 TRUE 5 ไม่เท่ากับ 6 



3) ตัวด่าเนินการทางข้อความ (Text Operator)  

เครื่องหมายด าเนินการทางข้อความคือเครื่องหมาย & ซึ่งท าหน้าที่เชื่อมข้อความหรือสูตรค านวณ ท าให้
แสดงผลลัพธ์ต่อเนื่องกันได้  เช่นตัวอย่าง 
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รูปภาพท่ี 11 ตัวด่าเนินการทางขอ้ความ (Text Operator) 

4) ตัวด่าเนินการอ้างอิง (Reference Operator) 

 ใช้ในการอ้างอิงต าแหน่งบนเวิร์คชีท โดยใช้เครื่องหมาย , (Comma) : (Colon) หรือเว้นวรรค (Space) ใน
การอ้างอิงกลุ่มเซลล์เวิร์คชีท 

ตารางที่ 5 ตัวด่าเนินการอ้างอิง (Reference Operator) 

Operator  ความหมาย  ตัวอย่าง  
, (Comma)  ใช้อ้างอิงช่วงเซลล์ทั้งหมดท่ีอ้างถึง  =sum(B2:B5,D2:D5)  
: (Colon)  ใช้อ้างอิงช่วงเซลล์จากตาแหน่งแรก

ไปจนถึงตาแหน่งเซลล์สุดท้าย
ต่อเนื่องกัน  

=sum(B2:B5)  

เว้นวรรค 
(Space)  

ใช้อ้างอิงเฉพาะเซลล์ที่ซ้ากันในช่วง
เซลล์ที่ระบุ  

=sum(B2:D4 C3:E5) นาข้อมูลที่ซ้ากันในช่วง B2 ถึง D4 
และ C3 ถึง E5 มาบวกกันในที่นี้คือเซลล์ C3 C4 D3 D4  

 
 

5) ระดับความส่าคัญของตัวด่าเนินการ  

ตัวด าเนินการต่างๆนั้นมีล าดับความส าคัญต่างกัน ซึ่งโปรแกรมจะประมวลผลจากตัวด าเนินการระดับสูงไปยัง
ระดับรองลงมา หากภายในสูตรค านวณเดียวกันนั้นมีตัวด าเนินการที่มีระดับความส าคัญเท่าๆ กันจะค านวณจากซ้ายไป
ขวาจนครบ 

ตารางที่ 6ระดับความสา่คัญของตวัด่าเนินการ  

ที ่ ตัวด าเนินการ  ความหมาย  
1  ()  วงเล็บ  
2  %  เปอร์เซ็นต์ เช่น 50% โปรแกรมจะแปล่งค่าเป็น 0.5 ก่อนแล้วจึงค านวณค่าอ่ืนๆ  
3  ^  ยกก าลัง เช่น 2^5  
4  * และ /  คูณ และหาร  
5  + และ -  บวก และลบ  
6  &  น าข้อความตั้งแต่สองข้อความมาเชื่อมกัน  
7  =, <>, <=, >=, <>  ตัวด าเนินการเปรียบเทียบ  
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2.2 การสร้างสูตรค่านวณ  

หากต้องการใช้งานสูตรค านวณใน Excel นั้น สิ่งหนึ่งที่ต้องท าก่อนเสมอคือ “คลิกเลือกเซลล์ ที่ต้องการให้ผล
ลัพธ์แล้วจึงป้อนสูตรค านวณ”  การใส่สูตรลงในเซลล์ท าได้โดยคลิกเซลล์ที่ต้องการ แล้วพิมพ์สูตรลงไปในเซลล์โดยตรง 
หรือพิมพ์บนแถบสูตร (Formula Bar) ซึ่งมีการใช้งานดังนี้ 

 
รูปภาพท่ี 12 การสร้างสูตรค่านวณ 

2.3 การอ้างอิงเซลล์ (Reference)  

หากกล่าวถึงเรื่องการค านวณแล้ว การอ้างอิงเซลล์จัดเป็นเรื่องที่ควบคู่กัน กล่าวคือหากมีการใช้สูตรค านวณ
จะต้องมีการอ้างอิงข้อมูลที่บรรจุอยู่ในเซลล์ต่างๆ กัน เพ่ือให้สูตรการค านวณท่ีสร้างขึ้นนั้นมีความยืดหยุ่นต่อการใช้งาน 
มากกว่าการระบุตัวเลขค่าคงที่ลงไปทั้งหมดเอง เพราะเมื่อมีการเปลี่ยนแปลงข้อมูลหรือตัวเลขใดๆ ในเซลล์ข้อมูล 
ผลลัพธ์ต่างๆ ก็จะถูกเปลี่ยนแปลงไปด้วย ทาให้ผู้ใช้ไม่ต้องเสียเวลาในการป้อนสูตรค านวณอีกรอบ การอ้างอิงเซลล์นั้น
สามารถก าหนดได้หลายรูปแบบดังนี้  

2.3.1 การอ้างอิงเซลล์ภายในเวิร์คชีทเดียวกัน  

การอ้างอิงเซลล์ที่อยู่ในเวิร์คซีทเดียวกันจะต้องมีชื่อคอลัมน์และชื่อแถวในการอ้างอิงดังรูป 

 
รูปภาพท่ี 13 การอ้างอิงเซลล์ที่อยูใ่นเวิร์คซีทเดยีวกัน 

รูปแบบ 

=ชื่อเซลล์ (Cell)  มาจาก ชื่อคอลัมน์ชื่อแถว (ColumRow: CR)   

เช่น  =A1    A คือ ชื่อคอลัมน์   1 คือ ชื่อแถว 
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ตารางที่ 7 การอ้างอิงเซลล์ที่อยู่ในเวิร์คซีทเดียวกัน 

การอ้างอิง ความหมาย 
=A1  อ้างอิงข้อมูลที่อยู่ในเซลล์ A1  
=A1:A12  อ้างอิงข้อมูลตั้งแตเ่ซลล์ A1 ถึง A12  
=A1,A12,A14  อ้างอิงข้อมูลในเซลล์ A1, A12 และ A14  
=A1:A12,C1:C12 อ้างอิงข้อมูลตั้งแตเ่ซลล์ A1 ถึง A12 และตั้งแต ่C1 ถึง C12  
=A1:A12 A1:F5  อ้างอิงข้อมูลเซลล์ข้อมูลตั้งแต่ A1 ถึง A12 และ A1 ถึง F5 ซึ่งก็คือ A1:A5 นั่นเองเป็นการ

อ้างอิงเซลล์ร่วมกัน  
 

2.3.2 การอ้างอิงเซลล์ที่อยู่ในเวิร์คชีทอ่ืน  

การอ้างอิงเซลล์ที่อยู่ในเวิร์คชีทอ่ืนนั้น จะต้องมีชื่อเวิร์คชีทต้นทางแล้วตามด้วยเครื่องหมายอัศเจรีย์ (!) แล้วจึง
พิมพ์ชื่อเซลล์ ดังรูป  

 
รูปภาพท่ี 14 อ้างอิงเซลล์ที่อยู่ในเวิร์คชีทอื่น 

 

2.3.3 การอ้างอิงเซลล์ภายในเวิร์คบุ๊คอื่น  

 
การอ้างอิงเซลล์ที่อยู่ในเวิร์คบุ๊คอ่ืนนั้น จะต้องมีการอ้างอิงถึงชื่อไฟล์เวิร์คบุ๊คแล้วตามด้วยชื่อเวิร์คชีท และชื่อ

เซลล์ตามล าดับ  

 
รูปภาพท่ี 15 อ้างอิงเซลล์ที่อยู่ในเวิร์คบุ๊คอื่น 

 

  

รูปแบบ 

 =ชื่อเวิร์คชีท!ชื่อเซลล์ 

เช่น  =Sheet1!A1 

 

รูปแบบ 

 =[เวิร์คบุ๊คอ่ืน.xlsx]ชื่อเวิร์คชีท!ชื่อเซลล์ 

เช่น  =[บุคลากร.xlsx]Sheet1!A1 
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2.3.4 การอ้างอิงเซลล์แบบเจาะจง  

 
เมื่อผู้ใช้ท าการคัดลอกสูตรภายในเซลล์ต่างๆ ที่ถูกก าหนดไว้ในสูตรจะเปลี่ยนแปลงเองอัตโนมัติ แต่ในบางกรณี

เราไม่ต้องการให้เซลล์เปลี่ยน ต้องการระบุเจาะจงแค่เซลล์เดียว หรือกลุ่มเซลล์เพียงกลุ่มเดียว สามารถระบุได้โดยการ
ใช้สัญลักษณ์ $ (Dollar Sign) ใส่ไว้หน้าเซลล์ เช่น  
$A1 คือเจาะจงคอลัมภ์ แถวเปลี่ยนแปลงได้  
A$1 คือเจาะจงแถว คอลัมภ์เปลี่ยนแปลงได้  
$A$1 คือเจาะจงแถว และคอลัมน์  

 
รูปภาพท่ี 16 การอ้างอิงเซลล์แบบเจาะจง 

 
Tip การอ้างอิงเซลล์แบบเฉพาะเจาะจง สามารถกดปุ่มฟังก์ชัน F4 ที่คีย์บอร์ด เพ่ือทาการใส่เครื่องหมาย $ โดยการกด 
F4  
กดครั้งที ่1 จะเป็นการใส่ $ ทั้งหน้าคอลัมภ์และแถว ($A$1)  
กดครั้งที ่2 จะเป็นการใส่ $ หน้าแถว (A$1)  
กดครั้งที ่3 จะเป็นการใส่ $ หน้าคอลัมภ์ ($A1) 

 

2.4 การตั้งชื่อเซลล์และกลุ่มเซลล์ 

การค านวณข้อมูลภายในเซลล์นั้นเป็นการอ้างอิงต าแหน่งเซลล์หรือการระบุชื่อเซลล์ เช่น A4+A3 เป็นต้น ทั้งนี้
เราสามารถอ้างอิงต าแหน่งเซลล์ได้อีกลักษณะหนึ่งคือ การตั้งชื่อให้กับเซลล์ซึ่งอาจจะเป็นเซลล์เดียวกันหรือหลายเซลล์
ก็ได้ เพ่ืออ านวยความสะดวกในการอ้างอิงถึงต าแหน่งเซลล์จ านวนมาก ในการเข้าถึงข้อมูลหรือการน าไปค านวณ  

2.4.1การตั้งชื่อเซลล์หรือกลุ่มเซลล์ด้วย Name Box  

Name Box ใช้ในการแสดงชื่อต าแหน่งเซลล์ที่เลือกอยู่ และสามารถตั้งชื่อเซลล์หรือกลุ่มเซลล์ได้ โดยสามารถ
ท าตามข้ันตอนดังนี้  
1. คลิกเลือกเซลล์หรือกลุ่มเซลล์ที่ต้องการตั้งชื่อ  
2. พิมพ์ชื่อลงไปใน Name Box และกดปุ่ม Enter ที่คีย์บอร์ด  

รูปแบบ 

 =ชื่อเซลล์ 

เช่น  =$A1 =A$1 =$A$1 

 



คู่มือการอบรมเชิงปฏิบัติการเรื่อง การใช้คอมพิวเตอร์โปรแกรม Microsoft Excel Advance 14 

 

 
รูปภาพท่ี 17 การตั้งช่ือเซลล์หรือกลุ่มเซลลด์้วย Name Box 

2.4.2 การตั้งชื่อเซลล์หรือกลุ่มเซลล์ด้วย Define Name  

Define Name ใช้ในการตั้งชื่อกลุ่มเซลล์ โดยการก่าหนดขอบเขตการใช้งานและใส่ข้อคิดเห็นเพ่ิมเติมซึ่ง

สามารถท่าได้ดังนี้  

1. คลิกเลือกเซลล์หรือกลุ่มเซลล์ที่ต้องการตั้งชื่อ  

2. เลือกแท็บ Formulas  

3. คลิกปุ่ม Define Name  

4. ที่ช่อง Name ตั้งชื่อเซลล์  

5. ที่ช่อง Scope เลือกขอบเขตการเรียกใช้งานชื่อเซลล์ หรือคลิกที่ Refers to เพ่ืออ้างอิงกลุ่มเซลล์ใหม่  

6. ที่ช่อง Comment ระบุข้อคิดเห็นเพ่ิมเติม  

7. คลิกปุ่ม OK  

 
รูปภาพท่ี 18 การตั้งช่ือเซลล์หรือกลุ่มเซลลด์้วย Define Name 1 
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รูปภาพท่ี 19 การตั้งช่ือเซลล์หรือกลุ่มเซลลด์้วย Define Name 

2.4.3 การตั้งชื่อเซลล์หรือกลุ่มเซลล์ตามหัวคอลัมภ์หรือแถว  
การตั้งชื่อเซลล์โดยการน าเอาชื่อหัวรายการในกลุ่มข้อมูลมาตั้งชื่อเซลล์ โดยใช้วิธีเลือกชื่อหัวคอลัมภ์หรือหัว

แถวมาตั้งชื่อให้เซลล์ โดยมีขั้นตอนดังนี้  
1. คลิกกลุ่มเซลล์ทั้งหมดพร้อมหัวรายการ  
2. เลือกแท็บ Formulas  
3. คลิกปุ่ม Create from Selection  
4. คลิกเลือกค่าจากเซลล์ด้านที่จะนามาทาชื่อเซลล์  
5. คลิกปุ่ม OK  

ตารางที่ 8 การตั้งช่ือเซลล์หรือกลุม่เซลล์ตามหัวคอลมัภ์หรือแถว 

ค าส่ัง  ความหมาย  
Top row  ใช้ค่าในแถบบนสุดมาเป็นชื่อเซลล์  
Left column  ใช้ค่าของเซลล์ในคอลัมน์ซ้ายสุดเป็นชื่อเซลล์  
Bottom row  ใช้ค่าในแถวล่างสุดเป็นชื่อเซลล์  
Right column  ใช้ค่าของเซลล์ในคอลัมน์ขวาสุดเป็นชื่อเซลล์  
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รูปภาพท่ี 20 การตั้งช่ือเซลล์หรือกลุ่มเซลลต์ามหัวคอลัมภ์หรือแถว 1 

 
รูปภาพท่ี 21 การตั้งช่ือเซลล์หรือกลุ่มเซลลต์ามหัวคอลัมภ์หรือแถว 2 

2.5 การใช้งานฟังก์ชัน  

ฟังก์ชันซึ่งคือสูตรการค านวณที่ถูกสร้างไว้ มีลักษณะเหมือนคาสั่งส าเร็จรูป การท างานเพียงแค่ระบุชื่อฟังก์ชัน
ลงไปภายในเซลล์ที่ต้องการ หลังจากนั้นฟังก์ชันจะคืนค่าผลลัพธ์กลับมาให้ ฟังก์ชันภายใน Excel มีให้เลือกใช้มากมาย 
ทั้งฟังก์ชันทางคณิตศาสตร์ ฟังก์ชันทางการเงิน ฟังก์ชันทางสถิติ ฟังก์ชันทางข้อความ เป็นต้น  
2.5.1 ส่วนประกอบของฟังก์ชัน  

รูปแบบการใช้งานฟังก์ชันนั้นจะคล้ายกับการป้อนสูตรค านวณคือ จะต้องน าหน้าด้วยเครื่องหมายเท่ากับ (=) 
จากนั้นตามด้วยชื่อฟังก์ชันและค่าข้อมูล  

 

ชื่อฟังก์ชัน (Function)  คือ ชื่อฟังก์ชันตามที่ Excel ได้ก าหนดไว้ เช่นฟังก์ชัน SUM, COUNT  
ค่าข้อมูล (Argument)  คือ ค่าที่ต้องส่งให้ฟังก์ชัน ซึ่งจะอยู่ภายในวงเล็บ และการอ้าง 

Argument นั้น อาจจะใช้การอ้างอิงชื่อเซลล์แทนก็ได้  
 



คู่มือการอบรมเชิงปฏิบัติการเรื่อง การใช้คอมพิวเตอร์โปรแกรม Microsoft Excel Advance 17 

 

รูปภาพท่ี 22 ส่วนประกอบของฟังก์ชัน 

 
2.5.2 การใส่ฟังก์ชัน  

 
การสร้างสูตรค่านวณด้วยฟังก์ชัน สามารถเลือกใช้ฟังก์ชันโดยพิมพ์ชื่อฟังก์ชันลงไปเอง หรือเลือกฟังก์ชันจาก

กลุ่มค่าสั่ง Function Library  ซึ่งใน Excel 2013 ได้รวบรวมรายชื่อฟังก์ชันไว้ให้เรียกใช้งานได้อย่างสะดวกใน 

Ribbon ชื่อ Formulas โดยอยู่ในกลุ่มชื่อ Function Library และแยกฟังก์ชันออกเป็นประเภทการใช้งานต่างๆ 

 

 
รูปภาพท่ี 23 ฟังก์ชันจากกลุ่มค่าสั่ง Function Library 

ตารางที่ 9 ฟังก์ชันจากกลุ่มค่าสั่ง Function Library 

ค าสั่ง  ความหมาย  
Insert Function  เปิดไดอะล็อกบ็อกซ์แทรกฟังก์ชัน  
AutoSum  เลือกฟังก์ชันอัตโนมัติ  
Recently Used  เลือกฟังก์ชันที่ใช้ล่าสุด  
Financial  เลือกฟังก์ชันทางการเงิน  
Logical  เลือกฟังก์ชันทางตรรกะ  
Text  เลือกฟังก์ชันทางข้อความ  
Date & Time  เลือกฟังก์ชันวันที่และเวลา  
Lookup & Reference  เลือกฟังก์ชันการค้นหาและอ้างอิง  
Math & Trig  เลือกฟังก์ชันคณิตศาสตร์และตรีโกณมิติ  
More & Function  เลือกฟังก์ชันอืน่ๆเพ่ิมเติม  
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2.5.3 ประเภทของฟังก์ชัน  

ฟังก์ชันภายใน Excel มีหลากหลายชนิด เราสามารถแบ่งออกตามกลุ่มการท างานดังนี้  

1) ฟังก์ชันทางคณิตศาสตร์ (Math & Trig) 

ใช้ค านวณหาค่าทางคณิตศาสตร์หรือตรีโกณมิติ เช่นค่าผลรวม ค่าจ านวนเต็ม เป็นต้น  
ตารางที่ 10 ฟังก์ชันทางคณิตศาสตร์ (Math & Trig) 

ฟังก์ชัน  หน้าที่  
=INT (ตัวเลข)  คืนค่าจานวนเต็มปัดทศนิยมทิ้ง  
=TRUNC (ตัวเลข, จานวนทศนิยม)  คืนค่าตัวเลขและทศนิยมตามจานวนที่ต้องการ 

โดยปัดเศษท้ิง  
=ABS (ตัวเลข)  คืนค่าสมบูรณ์ของตัวเลข  
=SQRT (ตัวเลข)  คืนค่ารากที่สองของตัวเลข  
=ROUND (ตัวเลข, จานวนทศนิยม)  คืนค่าตัวเลขและทศนิยมตามจานวนที่ต้องการ  
=MOD (ตัวตั้ง, ตัวหาร)  คืนค่าเศษท่ีเหลือจากการหาร  
=SUM (ช่วงเซลล์)  หาผลรวม  
=SumIF (กลุ่มเซลล์ที่ตรวจสอบ, “เงื่อนไข”, กลุ่มเซลล์ที่
ต้องการหาผลรวม)  

หาผลรวมตามเงื่อนไข  

 

2) ฟังก์ชันทางสถิติ (Statistical) 

เป็นฟังก์ชันการวิเคราะห์ข้อมูลทางสถิติ ใช้ค านวณหาค่าทางสถิติต่างๆ เช่นค่าเฉลี่ย ค่าสูงสุด ค่าต่ าสุด การนับ
ตัวเลข เป็นต้น  

ตารางที่ 11 ฟังก์ชันทางสถิติ (Statistical) 

ฟังก์ชัน หน้าที ่
=MAX (กลุ่มเซลล์)  ค่าสูงสุดในกลุ่มเซลล์  
=MIN (กลุ่มเซลล์)  ค่าต่ าสุดในกลุ่มเซลล์  
=AVERAGE (กลุ่มเซลล์)  ค่าเฉลี่ยในกลุ่มเซลล์  
=AVERAGEIF (กลุ่มเซลล์, เงื่อนไข)  ค่าเฉลี่ยในกลุ่มเซลล์ตามเงื่อนไข  
=AVERAGEIFS (กลุ่มเซลล์, เงื่อนไข, กลุ่มเซลล์, 
เงื่อนไข, ...)  

ค่าเฉลี่ยในกลุ่มเซลล์ตามเงื่อนไขโดยสามารถหาได้หลาย
เงื่อนไข หลายช่วงข้อมูล  

=MIDIAN (กลุ่มเซลล์)  ค่าก่ึงกลางในกลุ่มเซลล์  
=MODE (กลุ่มเซลล์)  ค่าท่ีเกิดซ้ าหรือเกิดบ่อยที่สุดในกลุ่มเซลล์  
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ฟังก์ชัน หน้าที ่
=COUNT (กลุ่มเซลล์)  นับจ านวนข้อมูลเฉพาะตัวเลข  
=COUNTA (กลุ่มเซลล์)  นับจ านวนข้อมูลทั้งตัวเลขและข้อความ  
=COUNTBLANK (กลุ่มเซลล์)  นับจ านวนเซลล์ว่าง  
=COUNTIF (กลุ่มเซลล์, เงื่อนไข)  นับจ านวนข้อมูลตามเงื่อนไข  
=COUNTIFS (กลุ่มเซลล์, เงื่อนไขกลุ่มเซลล์, 
เงื่อนไข, ...)  

นับจ านวนข้อมูลตามเงื่อนไขโดยสามารถหาได้หลายเงื่อนไข 
หลายช่วงข้อมูล  

 
 

3) ฟังก์ชันทางวันที่และเวลา (Date & Time) 

ใช้ค านวณหาวันเวลา แสดงวันที่ปัจจุบัน เป็นต้น  
ตารางที่ 12 ฟังก์ชันทางวันท่ีและเวลา (Date & Time) 

ฟังก์ชัน หน้าที ่
=TODAY()  คืนค่าวันที่ปัจจุบัน  
=NOW()  คืนค่าวันที่และเวลาปัจจุบัน  
=YEAR(วัน/เดือน/ปี)  คืนค่าปี  
=MONTH(วัน/เดือน/ปี)  คืนค่าเดือน  
=DAY(วัน/เดือน/ปี)  คืนค่าวันที่  
=NETWORKDAYS(วันที่เริ่มต้น, วันที่สิ้นสุด)  คืนค่าจ านวนวันจากช่วงเวลา เฉพาะวันท าการ  
=YEARFRAC(วันที่เริ่มต้น, วันที่สิ้นสุด)  คืนค่าปีเป็นทศนิยม (หาอายุเป็นปี)  
=HOUR(เวลา)  คืนค่าเวลาเป็นชั่วโมง  
=MINUTE(เวลา)  คืนค่าเวลาเป็นนาที  

 

4) ฟังก์ชันทางการเงิน (Financial) 

ใช้ค านวณหาค่าทางการเงินต่างๆ เช่น มูลค่าเงินในอนาคต อัตราดอกเบี้ย เป็นต้น ฟังก์ชันทางการเงินมี
หลากหลายฟังก์ชัน ในส่วนนี้จะยกตัวอย่าง ฟังก์ชัน PMT ซึ่งเป็นฟังก์ชันที่ท าหน้าที่ค านวณหาค่าอัตราการผ่อนชาระ
เป็นงวดๆ ซึ่งมีวิธีการใช้งานดังนี้ 

 
รูปภาพท่ี 24 ฟังก์ชันทางการเงิน (Financial) 

รูปแบบ  
=PMT (rate ,nper ,pv)  

=PMT(อัตราดอกเบี้ยต่องวด, จ่านวนงวดทั้งหมด, เงินต้น) 
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5) ฟังก์ชันทางข้อความ (Text) 

ใช้ส าหรับจัดการข้อมูลทั้งตัวเลขและตัวอักษรในลักษณะต่างๆ เช่น แปลงตัวเลขให้เป็นข้อความ , ค้นหาและ
แทนที่ข้อความ เป็นต้น  

ตารางที่ 13 ฟังก์ชันทางข้อความ (Text) 

ฟังก์ชัน หน้าที ่
=CHAR(ตัวเลข)  แปลงตัวเลขเป็นตัวอักขระ  
=REPT(ข้อความ, จ านวนครั้ง)  พิมพ์ข้อความซ้ าตามจ านวนครั้งที่ระบุ  
=BAHTTEXT(ตัวเลข)  แปลงตัวเลขเป็นข้อความทางการเงิน  
=CONCATENATE(ข้อความ1, ข้อความ2, …)  รวมข้อความหรือตัวเลขให้เป็นข้อมูลเดียวกัน  
=UPPER  เปลี่ยนข้อความเป็นตัวพิมพ์ใหญ่  
=LOWER  เปลี่ยนข้อความเป็นตัวพิมพ์เล็ก  
=LEN() นับจานวนอักขระในเซลล์  

 
 

6) ฟังก์ชันทางตรรกศาสตร์  

ใช้ค านวณแบบก าหนดเงื่อนไข เช่น การเปรียบเทียบค่าที่ให้ผลลัพธ์เป็นจริงหรือเท็จ ได้แก่  
- ฟังก์ชัน IF ตรวจสอบเง่ือนไขการทางาน  

ฟังก์ชัน IF ใช้ส าหรับทดสอบเงื่อนไขและการตัดสินใจการท างาน ตามเงื่อนไขที่ก าหนดซึ่งจะใช้กับข้อมูลที่มี
ทางเลือกในการตัดสินใจหลายๆ ทางโดยโปรแกรมจะน าเงื่อนไขไปทดสอบและส่งค่ากับเป็นตรรกศาสตร์ว่าจริงหรือเท็จ 
ถ้าจริงให้ท าอะไร ถ้าเท็จให้ท าอะไร  

1. IF แบบเงื่อนไขเดียว  
มีรูปแบบดังนี้ 

 
รูปภาพท่ี 25 IF แบบเง่ือนไขเดียว 

 
ให้ค่าตามผลของเงื่อนไขว่า เป็นจริง (True) หรือเป็นเท็จ (False)  

ส่าหรับการใช้งานฟังก์ชัน IF นั้นสิ่งที่ส่าคัญที่สุดคือการก่าหนดเงื่อนไข ผู้ใช้จะต้องทราบว่าอะไรคือเงื่อนไข 

และจะตั้งเงื่อนไขอย่างไร 

รูปแบบ  

= IF(เงื่อนไข, ค่าท่ีได้เมื่อเงื่อนไขเป็นจริง, ค่าท่ีได้เมื่อเงื่อนไขเป็นเท็จ)  
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2. IF แบบหลายเงื่อนไข 
ส าหรับ IF แบบหลายเงื่อนไข เหมาะกับงานที่มีลักษณะการตรวจสอบการตัดสินใจแบบหลายๆ เงื่อนไข โดยมี

ลักษณะการเรียกใช้ฟังก์ชัน IF แบบซ้อนกันไปเรื่อยๆ ในส่วนของการพิสูจน์เงื่อนไขท่ีเป็นเท็จ ตามรูปแบบดังนี้  

 
รูปภาพท่ี 26 IF แบบหลายเงื่อนไข 

*** วงเล็บปิดเท่ากับจ านวน IF ***  

7) ฟังก์ชันค้นหาและอ้างอิง  

ฟังก์ชัน VLOOKUP ค้นหาข้อมูลตามแนวคอลัมน์  

ฟังก์ชันนี้จะใช้ส าหรับการค้นหาข้อมูลคอลัมน์ (Vertical) โดยเริ่มจากคอลัมน์ซ้ายสุดของตารางหรือฐานข้อมูล
หากพบข้อมูลตามค่าที่ส่งไป ก็จะส่งกลับค่าในแถวเดียวจากคอลัมน์ที่ระบุไว้ในตาราง ฟังก์ชัน Vlookup เป็นฟังก์ชันที่
มีประโยชน์มากในการที่จะอ้างอิงข้อมูลของตารางอ่ืนมาไว้ยังต าแหน่งที่ต้องการ โดยจะมี KEY ที่ใช้ในการเปรียบเทียบ
ค้นหา  
ส าหรับการใช้ Vlookup นั้นจะต้องมีส่วนประกอบที่ส าคัญ 2 ส่วนด้วยกัน คือ  
1. ตารางข้อมูลหลัก  2. ข้อมูลที่ต้องการนาไปค้นหาจากตารางหลัก  

 
รูปภาพท่ี 27 ฟังก์ชัน VLOOKUP ค้นหาข้อมูลตามแนวคอลมัน ์

รูปแบบ  
=IF (เงื่อนไขที ่1, ค่าท่ีได้เมื่อเงื่อนไขท่ี 1 เป็นจริง,  
  IF (เงื่อนไขที ่2, ค่าที่ได้เมื่อเงื่อนไขท่ี 2 เป็นจริง,…,  
  IF (เงื่อนไขที ่N, ค่าท่ีได้เมื่อเงื่อนไขท่ี N เป็นจริง,  
  ค่าสุดท้ายของทุกเง่ือนไข)))  
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รูปภาพท่ี 28 ฟังก์ชัน VLOOKUP ค้นหาข้อมูลตามแนวคอลมัน ์

ตัวอย่าง จากตารางข้อมูลในรูป เมื่อผู้ใช้ป้อนรหัสสินค้าในเซลล์  C2 ต้องการให้ปรากฏชื่อสินค้าและราคา

ขึ้นมา โดยชื่อสินค้าและราคาสินค้านั้นจะอ้างอิงจากกลุ่มเซลล์ตารางหลัก(F2:H10) ดังนั้นจึงต้องใช้วิธีการอ้างอิงข้อมูล

จากตารางหลักมาใช้งาน โดยน่าข้อมูลรหัสสินค้าเป็นคีย์ในการค้นหาข้อมูล โดยก่าหนดสูตร Vlookup ดังนี้ 

 
รูปภาพท่ี 29 ตัวอย่าง จากตารางข้อมูลในรูป 

 
  

รูปแบบ  
=VLOOKUP (lookup_value, table_array, col_index_num, [range_lookup])  

โดยที่  
lookup_value  คือ ค่าที่จะนาไปค้นหาในตารางข้อมูล (เซลล์ที่เป็นคีย์)  
table_array   คือ ต าแหน่งของตารางหลัก  
col_index_num  คือ ล าดับคอลัมน์ที่ต้องการน าข้อมูลมาแสดง โดยการนับ

ล าดับคอลัมน์นั้นจะเริ่มนับจากซ้ายสุดเป็น 1 และไล่เรียงไป
ตามลาดับ  

range_lookup  คือ ค่าตรรกะที่ระบุลงไปให้ Vlookup เลือกว่าจะส่งค่าใด
กลับจากผลการค้นหา เช่น TRUE, FALSE หรือไม่ใส่ค่า
อะไร 
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จากรูปเขียนสูตรได้ดังนี้  
=VLOOKUP(C2,F2:H10,2)  
C2   คือ เซลล์ที่เป็นคีย์ ต้องการน าไปค้นหาหรือน าไปเปรียบเทียบกับตารางหลัก  
F2:H10  คือ ต าแหน่งของตารางหลัก  
2   คือ ล าดับคอลัมน์ที่ต้องการน าข้อมูลมาแสดง จากตวัอย่างต้องการชื่อสินค้า ซึ่งเป็น  

คอลัมน์ล าดับที ่2 ของตารางหลักมาแสดง  
ส าหรับราคาสินค้านั้น ก็ท าเช่นเดียวกันกับชื่อสินค้า แต่เปลี่ยน Columnindex number เป็น 3 เพราะราคา

สินค้าเป็นข้อมูลที่อยู่คอลัมน์ล าดับที ่3 ของตารางหลัก  
Note:  

ฟังก์ชัน Vlookup นั้นมีข้อจ ากัดคือ คอลัมน์ซ้ายสุดจะต้องเรียงล าดับจะต้องเรียงล าดับข้อมูลจากน้อยไปหา
มากเสมอ และข้อมูลที่เป็นคีย์ในการค้นหานั้น จะต้องพิมพ์ให้ถูกต้องตามรหัส เพราะหากพิมพ์ผิดโปรแกรมจะไม่
สามารถหาค่าได ้
 

ฟังก์ชัน HLOOKUP ค้นหาข้อมูลตามแนวแถว  

การท างานจะคล้าย VLOOKUP แต่จะค้นหาข้อมูลในลักษณะเป็นแถวแนวนอน (Horizontal) โดยจะค้นหา
จากแถวที ่1 คือแถวบนสุด หากพบข้อมูลที่ตรงกับค่าที่ค้นหา ก็จะนาค่าที่อยู่ในแถวถัดไปมาแสดง 
จากรูปเขียนสูตรได้ดังนี้  

 
รูปภาพท่ี 30 ฟังก์ชัน HLOOKUP ค้นหาข้อมูลตามแนวแถว 

รูปแบบ  
=HLOOKUP (lookup_value, table_array, row_index_num, [range_lookup])  

โดยที่  
lookup_value  คือ ค่าที่จะน าไปค้นหาในตารางข้อมูล (เซลล์ที่เป็นคีย์)  
table_array   คือ ต าแหน่งของตารางหลัก  
row_index_num  คือ ล าดับแถวที่ต้องการน าข้อมูลมาแสดง โดยการนับล าดับ

แถวนั้นจะเริ่มนับจากแถวบนสุดเป็น 1 และไล่เรียงไป
ตามล าดับ  

range_lookup  คือ ค่าตรรกะที่ระบุลงไปให้ Hlookup เลือกว่าจะส่งค่าใด
กลับจากผลการค้นหา เช่น TRUE, FALSE หรือไม่ใส่ค่า
อะไร 
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รูปภาพท่ี 31 ผลลัพธ์ฟังก์ชัน HLOOKUP ค้นหาข้อมูลตามแนวแถว 

 
จากรูปเขียนสูตรได้ดังนี 

=HLOOKUP(C2,B6:J8,2)  
C2  คือ เซลล์ที่เป็นคีย์ ต้องการน าไปค้นหาหรือน าไปเปรียบเทียบกับตารางหลัก  
B6:J8  คือ ต าแหน่งของตารางหลัก  
2  คือ ล าดับแถวที่ต้องการน าข้อมูลมาแสดง จากตัวอย่างต้องการชื่อสินค้า ซึ่งเป็นแถวล าดับที่  

2 ของตารางหลักมาแสดง  
ส าหรับราคาสินค้านั้น ก็ท าเช่นเดียวกันกับชื่อสินค้า แต่เปลี่ยน Columnindex number เป็น 3 เพราะราคา

สินค้าเป็นข้อมูลที่อยู่แถวล าดับที ่3 ของตารางหลัก 
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3. การท่างานและจดัการฐานข้อมูล 

Microsoft Excel จัดเป็นโปรแกรมหนึ่งที่มีความสามารถในด้านของการจัดการเก็บข้อมูลโดยเฉพาะใน

เวอร์ชันนี้ได้เพ่ิมเนื้อที่ในการจัดเก็บข้อมูลมากยิ่งขึ้น ด้วยการเพ่ิมจ่านวนแถว จ่านวนคอลัมน์ที่มากขึ้นกว่าเดิม ท่าให้

ความสามารถในด้านนี้ของ Excel มีจดุเด่นขึ้นมาอย่างชัดเจน 

3.1 การเรียงลาดับข้อมูล (Sort)  

การเรียงล าดับข้อมูลจัดว่าเป็นอีกความสามารถหนึ่งที่มาพร้อมกับการจัดรูปแบบตารางอัตโนมัติซึ่งการ
เรียงล าดับจะมีลักษณะการเรียง ดังนี้  

3.1.1 เรียงจากน้อยไปหามาก  

โดยสามารถเรียงได้ทั้งตัวอีกษร ตัวเลข และวันที่ การเรียงล าดับเบ้ืองต้นสามารถท าได้ดังนี้  
1. คลิกเลือกเซลล์ในคอลัมน์ที่ต้องการเรียงล าดับ  
2. คลิกเครื่องมือ Sort & Filter ที่แท็บ Home เลือกประเภทการเรียงล าดับ  

 
รูปภาพท่ี 32 เรียงจากน้อยไปหามาก 
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3.1.2 เรียงจากมากไปหาน้อย  

โดยสามารถเรียงได้ทั้งตัวอีกษร ตัวเลข และวันที่ การเรียงล าดับเบ้ืองต้นสามารถท าได้ดังนี้  
1. คลิกเลือกเซลล์ในคอลัมน์ที่ต้องการเรียงล าดับ  
2. คลิกเครื่องมือ Sort & Filter ที่แท็บ Home เลือกประเภทการเรียงล าดับ  

 
รูปภาพท่ี 33 เรียงจากมากไปหานอ้ย 

3.1.3 เรียงล่าดับแบบก่าหนดเอง  

การเรียงล าดับแบบก าหนดเองสามารถท าได้ดังนี้  
1. คลิกเมาส์ภายในกลุ่มเซลล์    
2. คลิกแท็บ Home  
3. คลิกเครื่องมือ Sort & Filter    
4. เลือกค าสั่ง Custom Sort ….  
5. ก าหนดรายละเอียด  - เลือกฟิลล์ที่ต้องการเรียง - เลือกประเภทการเรียง (น้อยไปมาก หรือ มากไปน้อย)  
6. คลิกปุ่ม OK  
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รูปภาพท่ี 34 เรียงล่าดับแบบก่าหนดเอง 

3.1.4 เรียงล่าดับชุดข้อมูล (Series)  

ส าหรับข้อมูลแบบชุด (Series) เช่น จันทร์, อังคาร, พุธ,... อาทิตย์ หรือ มกราคม, กุมภาพันธ์, มีนาคม,... , 
ธันวาคม นั้นไม่สามารถใช้การเรียงแบบปกติได้ เนื่องจากการเรียงข้อมูลแบบปกตินั้นจะเป็นการเรียงตามตัวอักษร ก 
ถึง ฮ หรือ A ถึง Z และเรียงตามค่าของตัวเลข ดังนั้นหากเป็นการเรียงล าดับแบบธรรมดาจะไม่สามารถเรียงได้ถูกต้อง 
เพราะฉะนั้นหากต้องการเรียงล าดับข้อมูลชนิดนี้จะต้องอาศัยตัวเลือกเสริมอ่ืนๆ ซึ่งมีอยู่ในหน้าต่าง Sort อยู่แล้วดังนี้  
1. เลือกฟิลล์ที่ต้องการเรียง    
2. คลิกเลือก Custom List… ในส่วนของประเภทการเรียง  
3. เลือกข้อมูลตามรูปแบบที่ต้องการเรียง   
4. คลิกปุ่ม OK  
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รูปภาพท่ี 35 เรียงล่าดับชุดข้อมูล (Series) 

3.2 การกรองข้อมูล (Filter)  

เมื่อจัดรูปแบบตารางแล้วจะสังเกตได้ว่าที่หัวตารางจะปรากฏตัวกรองข้อมูล เพ่ือใช้ในการเรียกดูข้อมูลบาง
ประเภทตามต้องการ เช่น ต้องการดูข้อมูลเฉพาะคนที่ข้ึนต้นด้วย “นาย” เป็นต้น  ความสามารถในการกรองข้อมูลของ
ตารางที่ได้ผ่านการจัดรูปแบบแล้ว มีวิธีการใช้งานเครื่องมือในการกรองข้อมูลดังนี้  
1. เลือกกลุ่มเซลล์ที่ต้องการ  
2. คลิกแท็บ Home  
3. คลิกเครื่องมือ Sort & Filter  
4. เลือกคาสั่ง Filter  
5. คลิกปุ่มลูกศร ที่หัวคอลัมน์  
6. เลือกข้อมูลที่ต้องการกรอง  
7. คลิกปุ่ม OK  
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รูปภาพท่ี 36 การกรองข้อมูล (Filter) 

รูปแบบในการกรองข้อมูลนั้นสามารถเปลี่ยนแปลงไปได้อิสระตามข้อมูล เช่น ข้อมูลที่เป็นตัวเลข ข้อมูล

ตัวอักษร หรือข้อมูลที่เป็นวันที่ ตัวเลือกต่างๆ ของแต่ละฟิลล์จะเปลี่ยนแปลงไปเรื่อยๆ ตามข้อมูลที่บรรจุอยู่ในคอลัมน์

นั้นๆ 



3.2.1 การก่าหนดเงื่อนไขเอง (Custom Filter)  

การกรองข้อมูลนั้นนอกจากจะใช้วิธีการเลือกจากตัวเลือกที่โปรแกรมมีให้แล้ว ยังสามารถก าหนดได้เองจาก
การเลือก ตัวเลือก Filters เช่น ต้องการกรองข้อมูลพนักงานที่มีค่าเป็นช่วง หรือต้องการหาค่าเฉลี่ยของเงินเดือน
พนักงาน เป็นต้น ในการกรองข้อมูลเองนี้สมมุติว่าต้องการกรองข้อมูลตัวเลขที่เป็นเงินเดือน สามารถท าได้ดังนี้  
1. คลิกปุ่มลูกศร  
2. เลือกคาสั่ง Number Filters  
3. เลือกเง่ือนไขที่ต้องการ  
4. ก าหนดตัวเลขตามเงื่อนไขที่ต้องการ  
5. คลิกปุ่ม OK  
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รูปภาพท่ี 37 การก่าหนดเง่ือนไขเอง (Custom Filter) 1 

 
รูปภาพท่ี 38 การก่าหนดเง่ือนไขเอง (Custom Filter)

3.2.2 ใช้เงื่อนไขขั้นสูง (Advance Filter)  

นอกจากการกรองข้อมูลโดยทั่วไปแล้ว เรายังสามารถสร้างเงื่อนไขในการกรองข้อมูลขั้นสูงได้ ด้วยการเลือก
พ้ืนที่วางเงื่อนไขและพ้ืนที่วางผลลัพธ์แยกออกมาต่างหากได้ โดยใช้คาสั่ง Advanced ในการก าหนดพ้ืนที่ค้านหาและ
การกรองข้อมูลได้ดังนี้  
1. สร้างพ้ืนที่เงื่อนไข  
2. พิมพ์เงื่อนไข  
3. คลิกกลุ่มข้อมูลพ้ืนที่ในการค้นหา  
4. ที่แทบ็ Data คลิกปุ่ม Advanced  
5. กาหนดพื้นที่การค้นหา  

- List range : คลิกเลือกพ้ืนที่การค้นหา  
- Criteria range : คลิกเลือกพ้ืนที่เงื่อนไข  
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- Copy to : คลิกเลือกเซลล์ที่จะแสดงผล  
6. คลิกปุ่ม OK  

 
ผลลัพธ์ที่ได้จากการก่าหนดเงื่อนไขในการกรองข้อมลู 
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รูปภาพท่ี 39 ใช้เงื่อนไขขั้นสูง (Advance Filter) 

3.3 การจัดกลุ่มข้อมูล (Group)  

เมื่อข้อมูลมีจ านวนมาก บางครั้งทาให้การค้นหาข้อมูลหรือการเรียกใช้ข้อมูลท าได้ล่าช้า ซึ่งเราสามารถแบ่ง
ข้อมูลออกเป็นกลุ่มๆ ได้ เพื่อความสะดวกในการเรียกใช้งาน  
การจดักลุ่มข้อมูลจะแบ่งโดยใช้คอลัมน์และแถวในการแบ่งเป็นหลัก โดยวิธีการดังนี้  
1. ลากคลุมช่วงข้อมูลที่ต้องการจัดกลุ่ม  

2. เลือกแท็บ Data  

3. ที่กลุ่มค าสั่ง Outline คลิกปุ่ม Group  

4. เลือกการจัด Group ตาม Row หรือ Columns จากนั้นกดปุ่ม OK เพ่ือยืนยัน  
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รูปภาพที่ 40 การจัดกลุม่ข้อมูล (Group) 

 
รูปภาพท่ี 41 ผลลัพธ์ทีไ่ด้การจัดกลุ่มข้อมูล (Group) 

 

การยกเลิกจัดกลุ่มข้อมูล (Ungroup) สามารถท่าได้โดยวิธีการดังนี้  

1. ลากคลุมช่วงข้อมูลที่ต้องการยกเลิกการจัดกลุ่ม  
2. เลือกแท็บ Data  
3. ที่กลุ่มค าสั่ง Outline คลิกปุ่ม Ungroup  
4. เลือกการยกเลิก Group ตาม Row หรือ Columns จากนั้นกดปุ่ม OK เพ่ือยืนยัน  
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รูปภาพท่ี 42 การยกเลิกจัดกลุม่ขอ้มูล (Ungroup) 

3.4 การแบ่งแยกข้อมูลจากคอลัมน์เดียวออกเป็นหลายคอลัมน์ (Text To Column)  

ในกรณีที่ข้อมูลถูกสร้างภายในคอลัมน์เดียวกัน เช่น ชื่อ-นามสกุล เราสามรถแยกข้อมูลที่อยู่ในคอลัมน์เดียวกัน
นั้นแบ่งออกเป็นหลายคอลัมน์ได้ เพ่ือความสะดวกในการเรียกใช้ข้อมูล โดยวิธีการดังนี้  
1. เลือกคอลัมน์ที่ต้องการแยกข้อมูลออก  

2. ที่แท็บ Data กลุ่มค าสั่ง Data Tolls คลิกปุ่ม Text to Column  
3. จะปรากฏไดอะล็อกบ็อกซ์ Convert Text to Columns Wizard ให้ก าหนดรายละเอียดเพิ่มเติม  
4. Step 1: เลือกชนิดของข้อมูลต้นฉบับว่าต้องการแบ่งแบบไหน  

Delimited:  แบ่งตามตัวคั่น เช่น แท็บ คอมม่า หรือช่องว่าง  
Fixed width:  ก าหนดความกว้างแต่ละคอลัมน์เท่ากัน เช่น แบ่งช่องละ 10 ตัวอักษร  

5. คลิกปุ่ม Next  
6. Step 2: เลือกตัวคั่นระหว่างคอลัมน์ว่า แต่ละส่วนถูกแบ่งด้วยเครื่องหมายใด  
7. คลิกปุ่ม Next 
8. Step 3: เลือกรูปแบบและต าแหน่งเซลล์ที่ต้องการแสดงผลลัพธ์ในช่อง Destination  
9. คลิกปุ่ม Finish  
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รูปภาพท่ี 43 Step 1: เลือกชนิดของข้อมูลต้นฉบับว่าต้องการแบ่งแบบไหน 

 
รูปภาพท่ี 44 Step 2: เลือกตัวคั่นระหว่างคอลมัน์ว่า แต่ละส่วนถูกแบ่งด้วยเครื่องหมายใด 
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รูปภาพท่ี 45 Step 3: เลือกรูปแบบและต่าแหน่งเซลล์ที่ต้องการแสดงผลลัพธ์ในช่อง Destination 

 
รูปภาพท่ี 46 ผลลัพธ์การแบ่งแยกข้อมูลจากคอลมัน์เดยีวออกเป็นหลายคอลมัน์ (Text To Column) 
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4. การใช้งานโปรแกรม Microsoft Excel เพื่อการจัดท่ารายงาน (Pivot Table)  

1.ทาความรู้จักกับการท่างานของ Pivot Table  

Pivot Table เป็นเครื่องมือที่ทรงพลังมาก ๆ ของ Microsoft Excel ใช้ส าหรับสรุปผลข้อมูลจ านวนมาก ๆ ใน
รูปแบบของตาราง และรูปแบบกราฟ (Pivot Chart)  

Pivot Table จะถูกสร้างจากข้อมูลใน Worksheet หรือ Range ที่มีข้อมูลต้องการจะใช้สรุปผล สามารถนา
เอาหัวข้อในแต่ละคอลัมน์มาใส่ใน Pivot Table เพ่ือใช้สรุปผลโดย จะมีด้วยกัน 4 ส่วนที่จะต้องลากเอาข้อมูลมาวาง
เพ่ือสรุปผล 

 

 
รูปภาพท่ี 47 Pivot Table 

2. เครื่องมือที่จะช่วยเสริมความเก่งกาจของ Pivot Table  

2.1 Pivot Chart  

การน าเอาข้อมูลที่สรุปผลมาน าเสนอในรูปแบบของกราฟ เพ่ือให้ดูได้ง่าย อาจจะเป็นกราฟแท่ง เส้น หรือ
วงกลม ก็ได้ โดยจะลิงค์กับข้อมูลดิบนั้น ๆ โดยหากมีข้อมูลการขายมาเพ่ิมก็สามารถทาการ Refresh เพ่ือสรุปผลที่ 
Update ได้ทันที  

2.2 Slicer  

ใช้ส าหรับการกรองข้อมูลที่ต้องการในแบบ interactive สามารถคลิกรายการที่ต้องการจะดู เช่นคลิกที่
รายการสินค้าที่จะดูยอดขาย เฉพาะสินค้านั้น ๆ สามารถเลือกได้หลาย ๆ รายการ และสามารถมีได้หลาย ๆ Slicer  
  

1. Row Label   = ใช้สรุปข้อมูลที่หัวของตารางทางด้านซ้าย  
2. Column Label  = ใช้สรุปข้อมูลที่หัวของตารางทางด้านบน  
3. Σ Values  = สรุปผลของข้อมูลที่ต้องการ โดยจะต้องก าหนดว่าจะใช้สูตรใด 

SUM, AVERAGE, MAX, MIN, COUNT เป็นต้น  
4. Filter  = ใช้ก าหนดว่าจะใช้คอลัมน์ใดเพ่ือใช้กรองข้อมูล โดยการแสดงผลจะ

เป็น Drop down list เพ่ือให้เลือกว่าเราจะกรองข้อมูลใด  
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2.3 Power Pivot  

ส าหรับใครที่จะต้องสรุปผลข้อมูลเกินความสามารถของ Excel ที่เบื้องต้นจะมี Row ให้เก็บข้อมูล 1,048,576 
แถว  

3.การเตรียมข้อมูลเพื่อการวิเคราะห์และสรุปผล  

1. ข้อมูลควรเก็บในรูปแบบของฐานข้อมูล  
2. ข้อมูลที่มีปริมาณมาก ๆ  
3. ข้อมูลจากฐานข้อมูลภายนอก (Import Data)  
4. เชื่อมต่อกับฐานข้อมูลภายนอก (Get External Data)  
5. ข้อมูลในรูปแบบหลาย ๆ ตาราง โดยแต่ล่ะตารางมีรูปแบบเดียวกัน (Consolidate)  

 
รูปภาพท่ี 48 List Table 
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4.การสร้างและการแก้ไข Pivot Table  

1. คลิกเลือกกลุ่มข้อมูล และคลิกแท็บ Insert > PivotTable  

 
รูปภาพท่ี 49Insert PivotTable 

 

2. คลิกเลือกตาราง หรือช่วงเซลที่จะนามาแสดง  

 
รูปภาพท่ี 50 Create Pivot Table 

3. คลิกเลือกต าแหน่งที่จะวาง PivotTable ในเวิร์กชีตเดิม หรือ วางในเวิร์กชีตใหม่ เมื่อเรียบร้อยแล้วคลิกปุ่ม OK  
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รูปภาพท่ี 51 เลือกต่าแหน่งที่จะวาง PivotTable 

 
 
 

 
รูปภาพท่ี 52 แสดงการเลือกข้อมูลเพื่อการสรุปผลเบื้องต้น 
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5.การเลือกและการจัดการ Field List  

1.ใช้ เมาส์ดึงชื่อ Field ไปยังช่องต่าแหน่งที่ต้องการ ส่าหรับพื้นท่ีแต่ละส่วนใน PivotTable มีไว้ส่าหรับใส่ชื่อฟิลด์ เพ่ือ

สร้างเป็นตารางสรุป โดยแต่ละส่วนมีความหมายดังค่าอธิบายในกล่องข้างๆ 

 
รูปภาพท่ี 53 Field List 

6.การเปลี่ยนแปลงสรุปข้อมูลใน PivotTable  

สมมตุิต้องการแสดงให้ข้อมูลเป็นรายปี โดย โดยลาก Year มาวางใสใ่น Field COLUMNS 

 
รูปภาพท่ี 54 เปลี่ยนแปลงสรุปข้อมูลใน PivotTable 

Report Filter 
ตัวกรองรายงาน 
ใส่ชื่อฟิลด์ที่ใช้แยก
ข้อมูลในตาราง
ออกเป็นกลุ่มย่อย 

Column Labels 
ป้ายชื่อคอลัมน ์
ใส่ชื่อฟิลด์ที่ใช้
แสดงข้อมูลในแนว
คอลัมน์ของตาราง 

Row Labels 
ป้ายชื่อแถว 
ใส่ชื่อฟิลด์ที่ใช้
แสดงข้อมูลในแนว
แถวของตาราง 

Values 
ค่า 
ใส่ชื่อฟิลด์ที่ใช้หา
ผลการค านวณใน
ตาราง 
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ท าให้ได้หน้าจอ สรุปผลข้อมูลใหม่   

 
รูปภาพท่ี 55 หน้าจอ สรุปผลข้อมูลใหม่   
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6. การกรอง (Filter) และการจัดกลุ่มข้อมูล  

การกรองข้อมูล โดยการเลือกสรุป ข้อมูลเฉพาะ Camera และ Mobile 

1. เลือก Filter เฉพาะข้อมูล Camera และ Mobile ตามด้วยการกดปุ่ม OK 

 
รูปภาพท่ี 56 การกรอง (Filter) 

2. ข้อมูลก็จะแสดง Camera และ Mobile ใน pivot table ดังรูปภาพ 

 
รูปภาพท่ี 57 หลังการ Filter ได้ผลแสดง Camera และ Mobile ใน pivot table 
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รูปภาพท่ี 58 ใช้งาน Filter Column ของปี 2010 และ2011 

3. การใช้งาน 2 Filter ร่วมกัน สมมุติต้องการให้แสดง แค่ Column ของปี 2010 และ2011 Row ของ Camera และ 

Mobile ก็ เลือก Filter Column ของปี 2010 และ2011 Row ของ Camera และ Mobile 

 
รูปภาพท่ี 59 ใช้งาน 2 Filter ร่วมกัน 
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7.การใส่ Slicer  

การ Insert Slicer เพ่ือให้การแสดงผลได้อย่างมีประสิทธิภาพ และก าหนดขอบเขตการแสดงผลข้อมูล  
1. เลือก Insert > Filters > Slicer  

 
รูปภาพท่ี 60 การ Insert Slicer 1 

2. เลือก รายการที่ต้องการ Insert Slicer เช่น Product และ Year แล้วกด ปุ่ ม ok 

 
รูปภาพท่ี 61 การ Insert Slicer 2 



คู่มือการอบรมเชิงปฏิบัติการเรื่อง การใช้คอมพิวเตอร์โปรแกรม Microsoft Excel Advance 46 

 

3. แสดง Slicer ของ Product และ Year ให้เลือกแสดงผลได้  

4. เลือกข้อมูลของ Product และ Year เพ่ือแสดงผลข้อมูลได้ 

 
รูปภาพท่ี 62 Slicer ของ Product และ Year 

8.การใช้งาน Pivot Table Design  

1. เลือก Pivot Table > Design 2. เลือกรูปแบบของ Report Layout  3. แสดงผล   

 
รูปภาพท่ี 63 Pivot Table Design 



คู่มือการอบรมเชิงปฏิบัติการเรื่อง การใช้คอมพิวเตอร์โปรแกรม Microsoft Excel Advance 47 

 

9. Pivot Chart  

สามารถสร้างแผนภูมิจาก PivotTable ได้ โดยใช้คาสั่ง Pivot Chart และเลือกประเภทแผนภูมิที่ต้องการซึ่ง
หากมีการเปลี่ยนแปลงข้อมูลแผนภูมิที่สร้างไว้ก็จะเปลี่ยนแปลงตามโดยอัตโนมัติสามารถท าได้ ดังนี้  
จากตัวอย่างข้อมูล  
1. คลิกเลือก Pivot Chart  

 
รูปภาพท่ี 64 Pivot Chart 

 
2. แสดงผลแผนภูมิแท่งอย่างง่าย  

 
รูปภาพท่ี 65 แสดงผลแผนภูมิแท่งอย่างง่าย 
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รูปภาพท่ี 66 แสดงผลแผนภูมิแท่งอย่างง่าย 

3.จากการเลือกข้อมูลโดยใช้ Slicer ท าให้ได้ข้อมูลที่จะนาไปสร้างแผนภูมิที่หลากหลาย ดังนี้   
 

 
รูปภาพท่ี 67 การเลือกข้อมูลโดยใช้ Slicer 1  
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รูปภาพท่ี 68 การเลือกข้อมูลโดยใช้ Slicer 

10. Case Study สร้าง Pivot Table ในหลากหลายการใช้งานดังนี้ 

1) การสร้าง Pivot Table จากตาราง Crosstab  

การสร้าง Pivot Table จากตาราง Crosstab โดยในตัวอย่างนี้จะเป็นการแสดงวิธีการสร้าง Pivot Table 

โดยอาศัยข้อมูลสถิติการจดทะเบียนรถยนต์ที่แยกตามปี เดือน และประเภทรถยนต์ 

2) การใช้ Pivot Table ในการ unpivot ตารางแบบ Crosstab 

เทคนิคการใช้ Pivot Table ในการ unpivot ข้อมูลที่อยู่ในรูปแบบตาราง Crosstab (ตารางไขว้) เช่น ตาราง

แสดงยอดขายของสินค้าแต่ละชนิดแยกตามป ี

3) การใช้ Pivot Table ในการ unpivot ตารางแบบ Crosstab หลายตารางพร้อม ๆ กัน 

เทคนิคการใช้ Pivot Table ในการ unpivot ข้อมูลที่อยู่ในรูปแบบตาราง Crosstab (ตารางไขว้) หลายๆ 

ตารางเข้าด้วยกัน เช่น ตารางแสดงยอดขายของสินค้าแต่ละชนิดแยกตามปีและสถานที่ขาย โดยแต่ละชีทจะเก็บ

ยอดขายของแต่ละเขตพ้ืนที่การขาย เช่น กรุงเทพ ภูเก็ต สมุย  
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4) การใช้ Pivot Table เพื่อรวมข้อมูลหลายส่วน (consolidate ranges) เข้าด้วยกัน 

การรวมข้อมูลจากหลายๆ ช่วงข้อมูลเข้าด้วยกันโดยใช้ Pivot Table เช่น หากมียอดขายสินค้าแยกตามภาค 

โดยแต่ละภาคถูกจัดเก็บในแต่ละชีทแยกจากกัน สามารถที่จะหาผลรวมของยอดขายทุกภาคได้โดยใช้ Pivot Table 

5) การใช้ตัวเลือกเวลา (Timeline slicer) เพื่อกรองข้อมูลใน Pivot Table 

เนื้อหาตอนนี้จะใช้ตัวอย่างของยอดขายรายวันของร้านอาหาร เพ่ือแสดงให้เห็นถึงการใช้ Time slicer โดย

เริ่มต้นจากการสร้าง Pivot Table ตามด้วยการสร้างและใช้ Timeline slicer เพ่ือเลือกช่วงของเวลาที่ต้องการจะ

แสดงใน Pivot Table โดยผู้ใช้สามารถเลือกหรือกรองข้อมูลได้ในระดับของ วัน เดือน ไตรมาส และปี 

6) การใช้แหล่งข้อมูลจากภายนอกมาสร้าง Pivot Table 

การสร้าง Pivot Table โดยใช้ข้อมูลที่เก็บอยู่ในไฟล์อ่ืน พร้อมทั้งบอกถึงเทคนิคในการใช้ไฟล์ที่เก็บข้อมูลที่

ไม่ได้เริ่มต้นที่ A1 
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5. การวิเคราะห์ข้อมูลด้วย Microsoft Excel (Analyzing Data) 

1. การใช้ตัวช่วยวิเคราะห์ข้อมูลอย่างรวดเร็ว (Quick analysis) 

มีเครื่องมือ Quick Analysis ให้ใช้เมื่อเลือกข้อมูลอย่างน้อย 2 เซลล์ขึ้นไปจะช่วยให้สามารถแปลง ข้อมูลไป

เป็นแผนภูมิหรือตารางได้ภายในสองขั้นตอนหรือน้อยกว่า แสดงตัวอย่างข้อมูลด้วยการจัดรูปแบบตามเงื่อนไข 

Formatting Charts Total Tables และ Sparklines ท่าให้ตัวเลือกของคุณโดดเด่นขึ้นได้ในคลิกเดียว  หรือ กด 

Ctrl+Q เพ่ือใช้งานเครื่องมือ Quick Analysis 

 
รูปภาพท่ี 69 Quick Analysis 

มีรูปแบบแผนภูมิที่เหมาะสมกับข้อมูลให้เลือกใช้ ด้วยเครื่องมือ Recommended Charts พร้อม เครื่องมือ

ด่วน ส่าหรับการตกแต่งแผนภูมิ (Fine tune charts quickly) 
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รูปภาพท่ี 70 Recommended Charts 

2. การดูแนวโน้มของข้อมูลโดยการสร้าง Trend (Create a Trend line) 

เตรียมข้อมูลที่มี แกน X ที่เป็นระยะเวลา และใช้เครื่องมือ Quick Analysis > Charts > Recommended 

Charts ดังรูปภาพ 

 
รูปภาพท่ี 71 การสร้าง Trend 
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3. การวิเคราะห์ข้อมูล (What-if Analysis) 

    ในหัวข้อนี้จะมาพูดถึงการวิเคราะห์ข้อมูลโดยใช้ What-if ซึ่งเป็นเครื่องมือการวิเคราะห์ที่อยู่ใน Excel การ

วิเคราะห์ข้อมูลแบบ What-if เป็นการเอาสูตรหรือข้อมูลที่มีมาวิเคราะห์เพ่ือหาทางเลือกจากสถานการณ์ต่างๆ โดยมี

การวิเคราะห์ 3 แบบ คือ สถานการณ์สมมติ(Scenario), ตารางข้อมูล(Data Table) และการค้นหาค่าเป้าหมาย(Goal 

Seek) สถานการณ์สมมติและตารางข้อมูลจะรับชุดของค่าข้อมูลเข้า( Input) และประเมินล่วงหน้า เพ่ือหาผลลัพธ์ที่

เป็นไปได้ ส่วนการค้นหาค่าเป้าหมายต่างจากสถานการณ์สมมติและตารางข้อมูลตรงที่ น่าผลลัพธ์มาประเมินย้อนกลับ 

เพ่ือหาค่าข้อมูลเข้าที่เป็นไปได้ที่ท่าให้เกิดผลลัพธ์นั้นๆ 

3.1 สถานการณ์สมมุติ (Scenario) 

การสร้างสถานการณ์สมมุติ สามารถสมมุติสถานการณ์ที่อาจเกิดขึ้น ซึ่งท่าให้ตัวแปรเปลี่ยนไปจากสถานการณ์

ปกติ แล้วน่ามาก่าหนดไว้ใน Scenario เพ่ือจะน่าไปสร้างรายงานสถานการณ์สมมุติต่อไปดังนี้ 

1. กรอกข้อมูลที่ใช้ในการค่านวณพร้อมกรอกสูตรที่ใช้ค่านวณ ตัวอย่าง เช่น การกู้เงิน ที่มีอัตราดอกเบี้ยระยะเวลาผ่อน

ช่าระ(งวด) จ่านวนเงินกู้ยืม และ เงินผ่อนช่าระรายงวด (=PMT(E3/12,B4,B5)) ดงัรูปภาพ 

 
รูปภาพท่ี 72 ตัวอย่าง การกู้เงิน 
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2. คลกิเมนู ท่ี Data > What-if Analysis > Scenario Manager จะมีหนา้ต่าง Edit Scenario ข้ึนมาใหก้ดคลกิปุ่ ม 

Add…เพือ่สรา้งสถานการณ์สมมตใิหม่ 

 
รูปภาพที่ 73 Scenario Manager 

 

ตารางที่ 14 สถานการณ์สมมต ิ

รายการ Contract A 

สถานการณ์สมมต ิ

Contract B Contract C Contract D 

อัตราดอกเบี้ย 15% 16% 17% 18% 

ระยะเวลาผอ่นช่าระ (งวด) 180 190 180 185 

จ่านวนเงินกู้ยืม    1,000,000.00      1,000,000.00           1,200,000.00             950,000.00  

เงินผ่อนช่าระรายงวด -฿13,995.87 
   

3. ตัง้ชือ่สถานการณ์ ลงในชอ่ง Scenario name : (ชือ่สถานการณ์สมมต)ิ  

4. เลอืกชอ่งขอ้มลูทีต่อ้งการก าหนดว่าเปลีย่นแปลง (Edit Scenario) > ok 

 
รูปภาพท่ี 74 Edit Scenario 
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5. ระบุว่า Scenario Value เปลี่ยนแปลงไปของแต่ละช่อง ตามตารางท่ี 1 สถานการณ์สมมุติ และคลิกปุ่ม Add เพ่ือ

สร้างสถานการณ์สมมติใหม่จนครบ Contract B Contract C และ Contract D 

 
รูปภาพท่ี 75 Scenario Value 

  
รูปภาพท่ี 76 รายการ Scenario B C และ D 

- การสร้างรายงานสถานการณ์สมมุติ 

เมื่อได้สร้างสถานการณ์สมมติไว้หลาย ๆ สถานการณ์แล้ว ให้น่ามาจัดท่าเป็นรายงานสรุปว่าจะได้ผลลัพธ์

เปลี่ยนแปลงไปเป็นอย่างไร 

1. คลิกปุ่ม Summary (เพ่ือสร้างรายงาน)  

2. คลิกเลือกชนิดรายงานที่ต้องการ  ซึ่งถ้า ให้เลือก  

- Scenario Summary การสรุปสถานการณ์สมมุติ (การรายงานแบบส่าเร็จรูป) 

- Scenario PivotTable สถานการณ์สมมติ (การรายงานที่ปรับเปลี่ยนได้ง่าย) 

3. เลือก Result Cell ที่ต้องการ แล้ว คลิกปุ่ม OK 
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รูปภาพท่ี 77 การสร้างรายงานสถานการณส์มมุต ิ

 

 
รูปภาพท่ี 78 Scenario Summary การสรุปสถานการณส์มมุต ิ

4. ไดร้ายงานสถานการณ์สมมุติดังรูปภาพ 

 

รูปภาพท่ี 79 รายงานสถานการณส์มมตุ ิ
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3.2 การค้นหาค่าเป้าหมาย(Goal Seek) 

            ปกติเวลาค่านวณจะค่านวณตามล่าดับ เช่น ยอดขาย–ค่าใช้จ่าย = ก่าไร แต่ Goal Seek ใช้การระบุผลลัพธ์

ที่ต้องการ (Output) แล้วค่านวณค่าข้อมูลเข้า (Input) เพ่ือให้ได้ผลลัพธ์ตามที่ต้องการ 

            ตวัอย่าง การค่านวณเงินกู้ ปกติจะค่านวณจากเงินต้น ระยะเวลาที่กู้ และดอกเบี้ย และใส่สูตรด้วยฟังก์ชัน 

PMT (ดูภาพที่ 34 ) ซึ่งจะได้จ่านวนเงินที่ต้องจ่ายในแต่ละเดือน (ดูภาพที่ 35) 

 
รูปภาพท่ี 80 ค่านวณอัตราผ่อนช่าระต่องวด 

 

รูปภาพที่ 81 จ่านวนเงินที่ต้องจ่ายในแต่ละเดือน 
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เงื่อนไขท่ี 1 : ถ้ามีต้องการผ่อนต่อเดือน 10,000 บาท ในระยะเวลา 10 ปี สามารถใช้ Goal Seek ค่านวณให้ได้ว่า จะ

สามารถกู้เงินได้เท่าไหร่? ไปที่ Data > What-if Analysis > Goal Seek (ดูภาพท่ี 36) 

 

รูปภาพที่ 82 เลือกค่าสั่ง Goal Seek 

ในหน้าต่าง Goal Seek (ดูภาพท่ี 37) : 

Set cell – cell ที่จะใช้ตั้งค่า โดยคลิกเลือก cell ที่เขียนสูตรเอาไว้ (ในตัวอย่างนี้คือ B5) 

To value – ระบุค่าเป้าหมายที่ต้องการ (ต้องการผ่อนเดือนละ 10,000) 

By changing cell – ระบุ cell ที่ต้องการให้เปลี่ยนแปลงค่าตามเป้าหมายที่ก่าหนดไว้ (จ่านวนเงินที่กู้ได้) 

 

รูปภาพที่ 83 ก่าหนดค่าเป้าหมาย 



คู่มือการอบรมเชิงปฏิบัติการเรื่อง การใช้คอมพิวเตอร์โปรแกรม Microsoft Excel Advance 59 

 

สรุป ถ้าต้องการผ่อนเดือนละ 10,000 เป็นระยะเวลา 10 ปี จะต้องกู้เงินจ่านวน 949,363 บาท (ดูภาพที่ 38) 

 

รูปภาพที่ 84 ค่าตอบที่ได้ของเงื่อนไขท่ี 1 

 

เงื่อนไขท่ี 2 : ถ้าต้องการกู้เงิน 1,000,000 บาท และผ่อนช่าระเดือนละ 10,000 บาท จะต้องใช้เวลาเท่าไหร่? (ดูภาพท่ี 

39) 
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รูปภาพที่ 85 ก่าหนดค่าเป้าหมาย 

 

สรุป ถ้าต้องการกู้เงิน 1,000,000 บาท และผ่อนช่าระเดือนละ 10,000 บาท จะต้องใช้เวลาประมาณ 129 เดือน (ดู

ภาพที่ 40) 

 

รูปภาพที่ 86 ระยะเวลาผ่อนช่าระ(เดือน) 

3.3 ตารางข้อมูล(Data Table)  

            จากตัวอย่าง หากต้องการทราบว่าช่วงเงินกู้ระหว่าง 800,000-1,700,000 บาท ถ้าให้ระยะเวลาผ่อน 10 ปี

ด้วยกันจะต้องผ่อนเดือนละเท่าไหร่ ใส่ค่าช่วงของเงินกู้ที่ต้องการเปลี่ยนแปลง ส่วนจ่านวนเงิน 10,533 ให้กด = แล้ว 

Link ไปที่ช่องผลลัพธ์ที่ค่านวณไว้แล้ว ในที่นี้ = B5 ของตัวอย่างที่1 ลากคลุม cell ตามภาพที่ 41  จากนั้นไปที่ Data 

> What-if Analysis > Data Table…  ที่นี้จะลองเปลี่ยนยอดเงินกู้ ซึ่งเรียงกันอยู่ในรูปแบบ Column  ดังนั้นต้องใส่

ค่า “จ่านวนที่กู้” ลงใน Column Input Cell จะได้ผลลัพธ์ดังภาพที่ 42 

 
รูปภาพที่ 87 แสดงวิธีค่านวณด้วยค่าสั่ง Data Table 
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รูปภาพที่ 88 ยอดผ่อนต่อเดือนตามจ่านวนเงินกู้ 

สมมติอยากรู้ว่าถ้ายอดเงินกู้ และ ระยะเวลาเปลี่ยน จ่านวนเงินที่จะต้องผ่อนต่อเดือนจะเป็นเท่าไหร่?? 

ให้ Copy ช่วงเงินกู้มาตั้งไว้ในแนว Column เหมือนเดิม เพ่ิมเติมคือระยะเวลาให้ใส่แนว Row (ดูภาพที่ 43) และ

ผลลัพธ์ในภาพที่ 44 

 
รูปภาพที่ 89 แสดงการค่านวณ Data Table 2 Input 
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รูปภาพที่ 90 ผลลัพธ์การเปลี่ยนแปลงยอดผ่อนต่อเดือน  
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6. การท่างาน Collaborating with others ร่วมกบั Microsoft Excel  

 

1. การแชร์ Workbook (Share a Workbook) 

วิธีการแชร์ไฟล์เอกสาร Excel ให้แก้ไขงานได้พร้อมกันหลายคนในเวลาเดียวกัน เพื่อนๆหลายคน เคยเจอ

ปัญหา ไหมครบัเวลาที่ต้องท่างานบน File Excel เดียวกันพร้อมกันหลายๆคน แต่ต้องรอให้เพ่ือนท่าข้อมูลให้เสร็จ

เรียบร้อย ปิด File นั้นก่อนแล้วจึงจะสามารถเข้าไปเพ่ิมเติมหรือแก้ไขได้ วันนี้มีวิธีที่จะสามารถ ท่างานหรือแก้ไขงาน 

File เอกสาร Excel ได้พร้อมกันหลายคนในเวลาเดียวกัน มาดูวิธี ท่ากันนะครับ 

1. ใช้ค่าสั่ง Review เลือก Share Workbook  

2. จากนั้นระบบ จะแสดงหน้าต่าง Share workbook ให้ท่าการเลือก ช่อง Allow changes by more than one 

user... (อนุญาตให้ผู้ใช้มากกว่าหนึ่งคน...) แล้วคลิก ปุ่ม OK  

 
รูปภาพท่ี 91 Share a Workbook 
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3. Click advanced tab เพ่ือก่าหนดเงื่อนไขในการติดตามการแก้ไข  

Track changes 

- Keep change history for    ก่าหนดจ่านวนวันที่ต้องการบันทึกการแก้ไข  

- Don’t keep change history  ไม่มีการบันทึก 

Update changes  

- When file is saved      หลังการ save file  

+Automatically every      ปรับปรุงอัตโนมัติโดยก่าหนดเวลาเป็นนาที  

- Save my changes and see other’s change   save และแสดงการแก้ไขของ user อ่ืนด้วย  

- Just see other user’s change   แสดงการแก้ไขของผู้อ่ืน 

Conflicting changes between users 

- Ask me which changes win  ให้มี message ถามถึงการยอมรับในการแก้ไขว่าเป็น ของ user ใด  

- The change being save win   การแก้ไขของ user ทีก่าลังถูก save จะได้รับการ ยอมรับ  

 
รูปภาพท่ี 92 Share  Workbook advanced 

4. Click OK จะปรากฏ message ให้ท่าการ save file  

5. Click OK จะปรากฏ การ [Shared] ให้ทราบ บน Title bar 
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รูปภาพท่ี 93 Shared 

2. การติดตามการแก้ไขว่าใครท่าการแก้ไข Cell ใด ด้วย Track Change 

Tracking Changes: การติดตามการแก้ไข เมื่อมีการ share file ให้สามารถเข้าถึง และแก้ไขได้พร้อมกัน 

หลายๆ users ย่อมจะต้องมีข้อจ่าากัด และมักเผชิญกับปัญหาในเรื่องข้อมูล บน file นั้นๆ Excel สามารถแบ่งเบา

ปัญหาเหล่านี้ได้ด้วยค่า สั่งในการติดตามการแก้ไข โดยบันทึกการแก้ไขเก็บไว้ เมื่อต้องการค้นหาการแก้ไขก็จะสามารถ

แสดงการ บันทึกนั้นได้ 2 วิธีดังนี้  

1. แสดงด้วย comment ซึ่งมีลักษณะเป็น สามเหลี่ยมสีน้าเงิน บนด้านซ้ายของ cell หลังการ แก้ไข และ 

save file แล้วจะปรากฏสัญลักษณ์ ของ comment เมื่อเลื่อน mouse ชี้ลงบน cell ที่มี สัญลักษณ์ จะปรากฏ

ข้อความที่แสดงถึง user ที่ได้ท่าการแก้ไข, วันที่เวลาที่ได้แก้ไข comment จะ แสดงให้เห็นเพียงครั้งเดียวเท่านั้น คือ

การเปลี่ยนแปลงล่าสุด หลังจากนั้นเมื่อปิด file ลง comment จะไม่ปรากฏอีกจนกว่าจะมีการเปลี่ยนแปลงครั้งใหม่

เกิดข้ึน  

 
รูปภาพท่ี 94 แสดงด้วย comment 
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2. แสดงด้วย History ซึ่งเก็บบันทึกไว้ชั่วคราวบน Worksheet นั้นๆ ด้วยวธิีการก่าหนดดังนี้  

แท็บ Review > Track Changes > Highlight Changes  

 When: ให้ท่าการติดตาม บันทึกเมื่อใด 

 Who: ให้ท่าการติดตาม บันทึก ว่าใคร เปลี่ยนแปลง  

 Where: ให้ท่าการติดตาม บันทึก cell หรือ range ใด ถ้าไม่ก่าหนด หมายถึง ทั้งหมด  

 Highlight changes on screen แสดงการเปลี่ยนแปลงให้เห็นทันที่ เป็น comment  

 List changes on a new sheet แสดงรายการเปลี่ยนแปลงบน sheet ใหม่  

 
รูปภาพท่ี 95 Highlight Changes  
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รูปภาพท่ี 96 แสดงด้วย History 

3. การป้องกันไฟล์ (Protect Files) 

 
รูปภาพท่ี 97 Protect Files 
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7. การตดิตามการแก้ไข การเชื่อมโยงสตูร (Auditing Worksheets)  

ส่าหรับการท่างานกับสูตรที่มีการเชื่อมโยงกันซับซ้อน ต้องการตรวจสอบ ติดตามการเชื่อมโยงเพ่ือรู้ที่มา และ

ผลกระทบของสูตรการค่านวณได้ เครื่องมือ Formula Auditing ช่วยคุณได้ หากคุณเขียนสูตร หรือเห็นสูตรของคนอ่ืน

แล้วเริ่มงง และหากลองลาก Selection บางส่วนของสูตรที่สงสัย แล้วกด F9 แล้ว ก็ยังช่วยอะไรคุณไม่ได้ แนะน่าให้ใช้

เครื่องมือ Formula Auditing ที่อยู่ใน Ribbon แถบ Formula โดยเครื่องมือแต่ละอันเจ๋งๆ ทั้งนั้น 

 
รูปภาพท่ี  1 Auditing Worksheets 

1. Trace Precedents  

การติดตามว่าเซลนี้ไปเกี่ยวข้องกับเซลใด เอาไว้หาว่า มีช่องอะไร Link มาหาช่องที่เราก่าลังตรวจสอบบ้าง 

โดยจะมีลูกศรชี้ไปยังช่องนั้นๆ และสามารถกดซ่้าลงไปได้หลายๆ ครั้ง เพื่อให้มันย้อนกลับไปยังช่องที่ Link มาหาทอด

ถัดๆ ไปอีกสามารถดับเบิ้ลคลิ๊กท่ีลูกศรเพ่ือให้มันเด้งไปยังช่องต้นทางได้เลย (ช่องปลายทางลูกศร) 

 
รูปภาพท่ี  2 Trace Precedents 
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2. Trace Dependents  

การติดตามว่าเซลนี้ถูกอ้างอิงไปที่ใดบ้าง  เอาไว้หาว่าช่องที่เราก่าลังตรวจสอบ Link ไปที่ไหนบ้าง  โดยจะมี
ลูกศรชี้ไปยังช่องนั้นๆ และกดซ้่าได้หลายๆรอบเหมือนกัน สามารถดับเบิ้ลคลิ๊กท่ีลูกศรเพ่ือให้มันเด้งไปยังช่องปลายทาง
ได้เลย 

 
รูปภาพท่ี  3 Trace Dependents 

3. Remove Arrows  

เป็นการลบลูกศรที่เกิดจากการใช้ Trace ทั้งสองแบบ โดยสามารถเลือกลบแบบใดแบบหนึ่งหรือลบทั้งสอง

แบบดังรูป 

 
รูปภาพท่ี  4 Remove Arrows 
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4. Show Formula  

การปรับการแสดงผลบนชีทเป็นโชว์สูตร แทนการโชว์ผลลพัธ์จากสูตรดังรูปภาพ 

 
รูปภาพท่ี  5 Show Formula 

5. Error Checking  

การตรวจสอบข้อผิดพลาดของสูตรการค่านวณ (Locate Errors in Formulas) และ การดูข้อมูลที่อ้างอิงไม่

ถูกต้อง (Locate Invalid Data and Formulas)  

 
รูปภาพท่ี  6 Error Checking  
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6. Evaluate Formulas  

การติดตามดูค่าของตัวแปร แสดงวิธีการค่านวณช่องนั้นทีละ Step ตัวอย่าง ต้องการ Evaluate Formulas 
ของCell B6=INDEX(E5:G9,MATCH(B4,D5:D9,1),MATCH(B5,E4:G4,0)) Stepต่างๆจะท่างานตามล่าดับของการ
ค่านวณดังรูปภาพ 

 

 
รูปภาพท่ี  7 Evaluate Formulas Step by step 
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7. Watch Windows  

การใส่ค่าว่าจะติดตามช่องไหนเป็นพิเศษ (ใส่ได้หลายช่อง) ว่ามีค่าอะไร สูตรอะไร เป็นต้น 

 
รูปภาพท่ี  8 Watch Windows1 

 
รูปภาพท่ี  9 Watch Windows 
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8. การก่าหนดค่าการรกัษาความปลอดภัย (Security)   

การแนะน่าการป้องกันการเปิดอ่านไฟล์ การป้องกันการแก้ไขไฟล์ ซ่อนสูตร ล็อคเซลที่ไม่ต้องการให้แก้ไข โดย Excel 

มีความสามารถด้านความปลอดภัยหลายระดับโดยหลายท่านอาจจะยังไม่เคยรู้มาก่อน 

1. การก่าหนดรหัสผ่านให้ไฟล์ Excel 

วิธีนี้ต้องใส่ Password ก่อนถึงจะสามารถเปิดไฟล์ได้ วิธีนี้เป็นการป้องกันข้อมูลแบบง่ายๆ ใช้เมื่อข้อมูลนั้น

ส่าคัญหรือเป็นความลับ โดยการตั้ง Password ให้กับไฟล์สามารถท่าได้โดย 

1. กดปุ่ม Office > Save As  (ถ้าไฟล์นั้นเคยบันทึกไปแล้ว ให้บันทึกทับ โดยใช้ชื่อไฟล์เดิมได้เลย 

2. จะมีหน้าต่าง Save As ขึ้นมา ให้เลือกเมนู Tool > General Options 

 
รูปภาพท่ี  10 General Options 

4. จะมีหน้าต่าง General Options ขึ้นมา ให้ตั้ง Password ที่ต้องการ (Password to open) 
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รูปภาพท่ี  11 ตั้ง Password 

5. นอกจากก่าหนด Password ส่าหรับเปิดไฟล์แล้ว ยังสามารถก่าหนด 
- Always create backup  Excel จะสร้างไฟล์ส่ารองข้อมูลขึ้นมาให้โดยอัตโนมัติ เหมาะส่าหรับไฟล์ที่มี

ความส่าคัญ และมีการเปลี่ยนแปลงแก้ไขข้อมูลบ่อย 
- Password to modify จะแก้ไขข้อมูลในไฟล์ได้ต้องใส่ Password 
- Read-only recommended เมื่อเปิดไฟล์ขึ้นมา Excel จะให้เลือกว่าจะเปิดแบบอ่านอย่างเดียวหรือไม่ 

เพ่ือป้องกันการแก้ไขข้อมูล 
6.เมื่อกด OK แล้ว Excel จะให้เราพิมพ์ Password ที่ตั้งไว้อีกครั้ง เพื่อยืนยันความถูกต้อง 

 
รูปภาพท่ี  12 พิมพ์ Password ที่ตั้งไว้อีกครั้ง 
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2. การป้องกัน Worksheet & Workbook (Protect Sheet, Protect Workbook) 

ตั้งค่าล็อคไฟล์ Excel ป้องกันการแก้ไขเอกสาร ส่าหรับการใช้งานโปรแกรม Microsoft Excel ในการสร้าง

เอกสาร เพ่ือเป็นข้อมูลกลางส่าหรับหน่วยงาน หรือแชร์ให้คนอื่นๆ สามารถเปิดดูด้วย ผ่านระบบแชร์ไฟล์ในระบบแลน 

และต้องการให้เปิดอ่านได้เท่านั้น โดยที่ไม่สามารถแก้ไขเอกสารได้ ซึ่งสามารถก่าหนดได้ด้วย Protect sheet (การ

ป้องกันแผ่นงาน) หรือ Protect workbook (การป้องกันเวิร์กบุ๊ก) โดยท่าการก่าหนด Password เพ่ือป้องกันไม่ให้

สามารถแก้ไขไฟล์เอกสารได้มาดูขั้นตอนการตั้งค่าส่าหรับ Protect (การป้องกัน) 

 

 
รูปภาพท่ี  13 Protect 

1. เปิดไฟล์ Excel ที่ต้องการ หรือสามารถสร้างไฟล์ Excel แล้วท่าการบันทึก จากนั้นคลิกท่ีแถบ Review (รีวิว) และ

ภายใต้หัวข้อ Change (การเปลี่ยนแปลง) คลิกท่ี Protect Sheet (การป้องกันแผ่นงาน) 

 

 
รูปภาพท่ี  14 Protect Sheet (การป้องกันแผ่นงาน) 
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2.จากนั้นก่าหนด Password ที่ช่อง Password to unprotect sheet เสร็จแล้วคลิกท่ี OK 

 
รูปภาพท่ี  15 ก่าหนด Password 

 

3.หลังจากนั้นจะให้ระบุ Password อีกครั้งเพ่ือเป็นการยืนยัน เสร็จแล้วคลิกท่ี OK 

 
รูปภาพท่ี  16 ระบุ Password อีกครั้ง 
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4.จากนั้นจะสังเกตเห็น Protect sheet ได้เปลี่ยนเป็น Unprotect Sheet   

 
รูปภาพที่  17 Protect sheet ไดเ้ปลี่ยนเป็น Unprotect Sheet 

5.ขั้นต่อไปคือก่าหนดไม่ให้เพ่ิม Workbook หรือเพ่ิม Sheet โดยคลิกที ่Protect Workbook (การป้องกันเวิร์กบุ๊ก) 

 
รูปภาพท่ี  18 Protect Workbook (การป้องกันเวิร์กบุ๊ก) 

5.ก่าหนด Password ที่ช่อง Password (Optional) เสร็จแล้วคลิกท่ี OK 
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รูปภาพท่ี  19 ก่าหนด Password 

6.ระบุ Password อีกครั้ง แล้วคลิกท่ี OK 

 
รูปภาพท่ี  20 ระบุ Password อีกครั้ง  

7.เสร็จแล้วท่าการบันทึกไฟล์ แล้วท่าการปิด และเปิดไฟล์อีกครั้ง ซึ่งจะเห็นว่าไฟล์จะไม่สามารถแก้ไขได้ โดยจะ

สามารถอ่านได้เพียงอย่างเดียวเท่านั้น 

** โดยหากต้องการแก้ไขเอกสาร สามารถท่าได้โดยไปท่ี Unprotect Sheet และ Unprotect Workbook ตามข้อ 

1 และท่ีส่าคัญต้องไม่ลืม Password ด้วยนะครับ 
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3. การป้องกันไม่ให้เห็นสูตร และการป้องกันไม่ให้แก้ไขใน Cell ที่ต้องการ (Lock and Hidden) 

ถ้ามีเอกสาร Excel ที่มีสูตรลับอยู่ภายใน หรือเป็นสูตรที่ไม่อยากเปิดเผยให้คนอ่ืนเห็น หรือเหตุผลอ่ืนๆ ที่

ต้องการซ่อนสูตรเหล่านั้น สามารถซ่อนสูตรเหล่านั้นได้ และยังสามารถป้องกันการแก้ไขข้อมูลได้อีกด้วย โดยการ 

Protect Sheet ให้กับ Work Sheet ได้ด้วยวิธีการดังต่อไปนี้ครับวิธีการซ่อนสูตรไม่ให้มองเห็นสามารถท่าดังนี้ได้ครับ 

1.สร้างข้อมูลจ่านวน 2 เซล หรือหากมีข้อมูลที่ใช้กับสูตรอยู่แล้วข้ามไปได้เลยครับ 

2.สร้างสูตรโดยพิมพ์ = คลิ้กที่เซล 1 พิมพ์ + แล้วคลิ้กที่เซล 2 จากนั้น Enter 

 
รูปภาพท่ี  21 .สร้างสูตรโดยพิมพ์ 

3.คลิกเลือกเซลที่มสีูตร > จากนั้นคลิกเมาส์ขาวที่เซลนั้น > คลิ้กท่ีเมนู Format Cells… 

 
รูปภาพท่ี  22 Format Cells… 

 

4.ในหน้าต่าง Format Cells ให้คลิ้กเลือกท่ีแถบ Protection > จากนั้นกาถูกหน้าหัวข้อ Hidden หรือ Locked ตาม

ต้องการ > กดปุ่ม OK  
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**แต่ทว่าเซลนั้นจะยังไม่ซ่อนสูตรต้องท่าการป้องกันซะก่อนโดยท่าในข้ันตอนต่อไป 

 
รูปภาพท่ี  23 แถบ Protection 

 

5.คลิ้กท่ีเมนู Review > Allow User to Edit Ranges > Protect Sheet... ในหน้าต่าง Allow Users to Edit 

Ranges 

 
รูปภาพท่ี  24 Allow User to Edit Ranges 

6.กาถุกหน้าหัวข้อ Protect Worksheet and contents of … ในหน้าต่าง Protect Sheet > ใส่รหสัผ่าน > กดปุม่ OK 
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รูปภาพท่ี  25 ใส่รหัสผ่าน 

7.ใส่รหัสยืนยันอีกครั้ง > กดปุ่ม OK 

 
รูปภาพท่ี  26 ใส่รหัสยืนยันอีกครัง้ 

การแสดงผลจะได้สูตรที่สร้างไว้ก็จะถูกซ่อนไม่สามารถมองเห็นได้ แล้วเมื่อดับเบิลคลิ้กแก้ไขก็จะขึ้นหน้าต่าง

เตือนว่าไม่สามารถแก้ไขได้ ถ้าต้องการยกเลิกการซ่อนและแก้ไขกดปุ่ม Unprotect Sheet > ใส่รหัสผ่าน แล้ว กดปุ่ม 

OK 


